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Thank you for choosing a NIVELCO instrument. 
We are sure that you will be satisfied throughout its use! 

 

1. INTRODUCTION 

The HART ("Highway Addressable Remote Transducer") is a popular digital communication protocol designed for industrial process measurement 
applications. The special feature is that it uses a low-level modulation superimposed on the standard 4-20 mA current loop, which is now widely 
used for such measurements. Since the HART signal is small, and composed of sine waves, its average value is zero and does not significantly 
affect the accuracy of the analogue current signal, which can therefore still be used. This provides compatibility with existing systems, while 
allowing simultaneous digital communication for device configuration, status checking, diagnostics and so forth. 

The EView2 software 
has been designed for detection, polling and displaying primary measurement data as well as remote programming of NIVELCO’s HART-capable 
transmitters. The EView2 is able to handle maximum 15 units in one Node and able to handle up to 10 Nodes. 
Installed in a PC the software allows the menu driven remote programming (device parameters + HART commands). The software can collect data 
from the detected NIVELCO units and perform cyclic polling and displaying the measurement data. 
 
Provided functions of EView2: 
 Detection of the connected devices (also in Multidrop operation mode) 
 Universal HART commands – for (only) viewing of primary measurement data of non-NIVELCO field devices 
 NIVELCO manufactured device specific commands: 

 Downloading parameters from field device 
 Editing, uploading parameters into the field device 
 Loading parameter list from file, saving parameter list to file 
 Downloading linearization table from field device 
 Editing, uploading linearization table into the field device 
 Loading linearization table from file, saving linearization table to file 
 Display Echo Map (for non-contact principle devices) 
 Downloading service and information parameters 
 Sensor calibration (for pH transmitters) 
 Security password (protection against unauthorized usage) 

Note! However the Eview2 software makes setting of parameters easier in remote programming, the profound knowledge of the 
parameter system of the NIVELCO transmitters is indispensable. 
The Eview2 software provides data logging capability for max. 3 hours. 
The Eview2 software is acting as primary master on the network. While running the software, the use of an active secondary master unit (for 
example a hand held communicator) is strictly FORBIDDEN! 
 

2. MEASUREMENT SYSTEM 

System requirements: 
 Win XP, Win 7 32 or 64 bit 
 HART modem (e.g.: NIVELCO’s UNICOMM SAT-304 or UNICOMM SAK-305) connected to a virtual COM port 

The UNICOMM HART modem establishes communication line between HART-capable field devices and process controller computer. 
The UNICOMM HART modem is applicable for all HART-capable transmitters which use standard HART communication. 
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3. SOFTWARE INSTALLATION 

The software does not require installation, however prior to run the application we recommend installing the FTDI Driver (Virtual COM-PORT), 
available to download from the website of FTDI (http://www.ftdichip.com/Drivers/VCP.htm), or from the download section on NIVELCO’s 
homepage. 
 
 

4. USAGE OF Eview2 
 

4.1. START EVIEW2 

Run the application with EView2.exe file or double click on the desktop shortcut. 
 

4.2. ADD NETWORK 
 

Click the Add Network  button.
(Further details are described in chapter 
5.4.) 

 

Choose the communication port. 

 

Note: The EView2 is able to handle 
multiple (Nodes) current loop networks  
(maximum up to 10). If there is more 
then one current loop click again on the 
„Add Network” button (and repeat the 
same procedure as before) to add further 
current loops to the Node list. Switching 
between the loops can be done with the 
pages on the upper bar and the networks 
also appear in the „Node List” window. 
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4.3. SCANNING DEVICES 
 

Click the Detect  button. 
 
The Detect start all node button in the 
upper menu bar starts the device 
detection in all the connected 
communication ports, and the Detect 
button in the lower toolbar starts the 
device detection only on the selected 
communication port. 
(Further details are described in chapter 
5.5.2.) 

The below Scanning network window 
appears when the detection starts. 
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4.4. SELECT DEVICE(S) 
 

To select between the detected devices tick the checkbox next to the list number or insert the line. (Further details are described in chapter 5.5.2.) 
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4.5. DEVICE SETTINGS 
 

The software reads out all device 
parameters by clicking the 
Device settings  button and opens the 
remote programming and user settings 
window of the selected device. The 
software reads out the parameter values 
automatically. (Further details are 
described in chapter 5.6.) 

This window shows the device specific settings. The window 
consists of two main parts, on the left there is a navigation screen 
and on the right the modifiable settings are listed. 
 
The user selectable parameters of the Device Identification
menu are the following: 
 Short (HART) address 1  
 Name tag 2  
 Descriptor 3  
 Date 4  
 Message 5  
 
The previous values (before the modification) can be read out by 
clicking the Refresh  6 , 7  button. 
The modifications can be applied and send to the transmitter by 
clicking the a Send 8  button. 
To exit from the Device settings window just simply close the 
window. 
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4.6. START MEASUREMENT 
 

To start the measurement, tick the 
checkbox next to the list number of the 
detected device. 
Then the inactive Polling button became 
active. 
(Further details are described in the end of 
chapter 5.5.) 

 

To start visualize the measurement values 
click Polling  1  button. 
The opened small window shows cycle 
queried information, measured values 2  
and a Status „LED” 3  

1

2

3
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4.7. TREND LOGGING 
 

Since the Polling (querying the 
measurement data) is started (the maximal 
time limit is 3 hours) then the values can 
be displayed on a Trend Diagram. 
 
Click the Trend Window On  button in the 
upper menu bar or in the Device list 
window click the right mouse button on the 
line of the selected device to see the 
popup command list menu with more 
functions. Choose the Trend Window On 
command from this list menu. 
(Further details are described in chapter 
6.2.) 

The Trend Diagram window appears. 
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In the Trend Diagram window the right 
click popup menu provides many new 
settings. 
For example here you can find the data-
logging settings or start the Recording by 
pressing F6 or click Recording → Start  
command in the menu. Then the recorded 
Trend Diagram can be saved. (Further 
details are described in chapter 6.2.) 

 

Then a new window appears where the following settings 
should be selected for saving into file: 
 File type 1 , 
 File path 2 , 
 Date and time format 3 , 

 
The header settings of the saved file can be selected: 
 Name of the header datafields 4 , 
 Whether include the header datafields 5 , 
 and attach units to the datafields 6  

 
Click the OK  button to apply the settings. 

1

2

3
4

5 6

 

Click the Save Trend  command (Ctrl+F6) 
to save the measurement data to file and 
also select the saving settings when the 
Recording is in Stop state. 
This case the above setting window 
appears again with the same saving 
settings. 
(Further details are described in chapter 
6.2.) 
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5. DETAILED DESCRIPTION OF THE SOFTWARE 
 

5.1. RUNNING THE APPLICATION 

Run the application with EView2.exe file. 
 

5.2. MAIN SCREEN 
 

The following main screen appears as welcome screen: 
The main screen contains the following elements: 
 Menu bar: File, Device, Network, Setup, Tools, View, Window, Help 
 Quick buttons: Add network, Detect start all node 

 
The language (English, Hungarian, etc… ) can be selected at the Language menu point in the Setup  menu. 

 
 
 

5.3. ELEMENTS OF THE MAIN SCREEN 

In the drop-down menus of the menu bar the following functions can be reached: 

5.3.1. File menu 

Exit from EView2 (Alt+F4). 

5.3.2. Network menu 

From this menu Add Network (Ctrl + H), Del Network (Shift + Ctrl + D) and Del all Network can be selected. 

5.3.3. Setup 

In the Setup menu the language (English, Hungarian, etc… ) can be selected at the Language menu point. 

5.3.4. Tools 

In the Tools menu there are integrated tools like the Parameter File Editor & Viewer and the Record File Viewer. (Further details are described 
in chapter 7.) 

5.3.5. View 

Two functions can be found here: Node Log Window(s) and Project (F3). 
In the Node Log Window(s) menu point you can open the communication log for the given „Node window”. With the „Show All” / „Hide All” options 
all communication logs can be opened or closed with one click. 
The Communication Log displays all incoming and outgoing communication messages including warning and error messages are monitored. 
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The Project menu command (F3) activates the Node list on the left side. If the tick is deactivated in the menu the Device list fills the entire place 
available in the window. 
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5.3.6. Window 
In this menu you can select between the windows. The two options: Next window, Previous window can be used in case of multiple Nodes to scroll 
between the Nodes. 
 
5.3.7. Help 
The About window shows the general information of EView2, 
such as version number, registered user, date of release, 
contact e-mail address. 

 

The Device list window lists all the supported NIVELCO 
transmitter devices. 
 
On the left side there is the Device list containing the 
supported devices. On the right side the picture and a 
short description of the selected type appear. 

 
 

5.4. CONNECTION SETTINGS 

Click the Add network  quick button to choose the communication port of the network to be added. The following window appears: 
 

 
 

Click the More button to reach further settings. New settings appear in addition to the Add networks window: 
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Tick the Special detect mode On to activate the special settings of the detection mode to be modified. The special settings are described in the 
following figure: 

1

2

3

4

5

6

7

8

 

1   Timeout time is the time until the software is waiting for the answer 
packets. 
2   Cycle time is the time until the software is waiting for the queried 

information.  
3   The HART short address range can be specified for the Device 

Detection. 

4   Modem selection 
5   Refresh 
6   When the ‘Only first detect’ checkbox is ticked the Device Detection 

ends when the first unit is detected. 
7  Ticking the ’Save settings as default’ checkbox and clicking on the 

OK button will save the actual network settings as default. 
8  With the ’Clear default settings’ button you can delete the user-saved 

default setting and can reset to factory default values. 
Click the OK button to apply the network selection. Then the device list appears and a new toolbar including the Detection button becomes 
available. 
 
 
 

5.5. TOOLBAR 

The appearing new toolbar contains the following menu points: 
 Detect, Node settings, Polling, Device settings, Calibration, Trend window on, Trend window close 

 

5.5.1. Device list information 
 No.: List number (list numbers of the detected devices) 
 Address: HART Short address („0” for single device, „1..15” for multiple devices on the HART loop) 
 Factory: NIVELCO – given by HART Communication Foundation 
 Device type: Type identification number of the HART capable NIVELCO transmitters, - cannot be user modified 
 Device ID: The manufacturer’s electronic production number, - cannot be user modified 
 Tag: 8 byte device descriptor, usually order code, - can be modified by the user 
 Descriptor: Max. 16 byte arbitrary comment that can be assigned to the device and is generally operation principle-related, - can be modified 

by the user 
 Date: Can be assigned to the device (for example last modification of the Tag or Descriptor) - can be modified by the user 
 Message: Max. 32 byte arbitrary comment that can be assigned to the device and is generally operation-related, - can be modified by the user 
 Status: result of last programming or query data request: OK! or Error! 
 Time stamp: date of last data request 
 TX count: number of outgoing messages sent to a given device 
 RX count: number of incoming messages received from a given device 
 
Note! All data in the device list are queried from the devices. 
 



sas3030a0600h_02 ♦ 15/32 

5.5.2. Overview on the Toolbar 

With starting the Detect  the connected devices appear in the device list. 
The software queries the transmitters through the HART loop from address 0 to 15 and lists them with a list number. The software detects the 
devices in accordance to the „Short address” that is why two or more devices must not have the same Short address. The „Short address” and 
the list number are not the same. The devices receive the „Short address” by the factory calibration by the manufacturer. 
The device detection procedure can be stopped or aborted by clicking the Abort  button. Then a new window appears in order to confirm the 
abortion or go back to continue the detection. 
After the successfully finished device detection new command buttons became active in the toolbar (Polling – only if a device is selected by its 
checkbox next to its list number, Device Settings – with selecting the line of the device in the list, Calibration – only for pH analytical 
transmitters, Trend Window On – with selecting the line of the device in the list, Trend Window Close – when the trend window is opened). 
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Ticking the checkbox next to the list 
number of the selected device and clicking 
the activated ’Polling’ a new window 
appears. To select all devices in the list use 
the right mouse button popup menu and 
click the All measuring window On 
command. 
 
The data fields such as ‘Short address’, 
‘Tag’, ‘Descriptor’, ‘Message’, which are 
allowed for user modification which fields 
can be easily edited by double click on the 
device list. 
Warning! Modifying these parameters will 
result immediate changes in the device 
after pressing the Enter button. 

 

When the Show device info window 
checkbox is ticked at the bottom, the 
Polling window will be added with further 
identification datafields. 

 
When the Polling  button is clicked, the 
polling is started and the small window 
appears the continuous measurement data 
query starts. The maximum time interval of 
the Polling is 3 hours and the remaining 
time is indicated at the bottom status bar. 
To stop the measurement data query click 
again the Polling  button. 
To close the Polling window untick the 
checkbox of the selected device or use the 
right mouse button popup menu and click 
the Close all measure window command. 
 
1  
 Cyclically queried information, 
 Measurement values, 
 Devices specific data, further details 

are described in the user’s and 
programming manuals of the selected 
instruments 

2  
 Status LED 

1

2
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5.6. DEVICE SETTINGS 

After the successfully finished device detection all the connected devices appear in the device list. To modify device settings and perform remote 
programming the line of the device should be inserted. 
Opening the Device Settings window is possible only when the Polling is stopped. 
The device specific data and the detailed description of the programmable parameters of the transmitters can be found in the User’s & 
Programming manual of the selected device. The factory default parameter values can be also found in the manuals. 
 
By clicking the Device settings  button a new window appears: 

 

The device settings (specified for the given instrument) are 
accessible by the following tabs on the left. 
If the device parameters are received from the device a new 
window appears containing the device settings specified for the 
given instrument: 

Displayed Information screen contains: 
 
Device: Device name (series), Manufacturer, Serial number, Date, 
Hardware (HW) version, Firmware (SW) version 
Device Identification: Device Short HART Address, Tag, 
Descriptor, Date, Message, - the last two option can be refreshed 
 
The settings are described in details in the user’s and 
programming manual of the given instrument.  
To apply any parameter modifications click the Send button 
to send the new parameter values to the instrument. 
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Application: Selecting operation mode (level measurement in 
liquids or in solids), Selecting engineering system (Metric - EU, 
Imperial - US), Selecting unit for Primary Value (mm, cm, m; in, ft)

 

Outputs: Editing current output, relay output values 

 

Linearization curve: Further details are described in chapter 6.4.
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Click the Advanced  button on the bottom left corner to reach further device settings specified for the given instrument, for example: 
Tag and Descriptor, Sensor info, Output and PV, Calibration, Parameters, VMT, Special, Echo map. 

These advanced functions are allowed to be modified only by trained personnel for own risk, because modifications in these parameters may 
have serious effects on the used processes controlled by the measurement instruments. 

By clicking the Advanced  new menu points appear allowing 
configure additional device-specific features: 
At the Addressing section the Polling (HART Short) address can 
be selected. (Further details are described in chapter 5.5 -
Detection) 

Tag and Descriptor section: The Tag, Descriptor and the Date 
can be read out and modified. Click the Write button to apply the 
changes. 

Message section: An operation related message can be set here.

 

At the Parameters menu all user programmable device 
parameters are listed. Each parameter can be selected and then 
edited, get from the device or sent to the device, load from file and 
save to file. 
 
Perform the following step to modify the device parameters: 
1. Tick the checkbox of the selected Parameter 1 . 
2. Click the Get 2  button to query to current parameter value. 
3. The modified parameters can be applied and saved by clicking 

the Send 7  button, this case the parameters will be saved 
unless the procedure got cancelled. 

4. To save all parameters to a parameter list file click the Save 
5  button. 

To load the factory default values click the Load default 4  
button. Then a ‘Warning’ window appears in order to confirm 
loading the default values or cancel. 
The Refresh 6  (Refresh) button queries again all parameters 
from the instrument. If any modification is made the Send 7  
button became active and all modifications can be sent to the 
instrument. 

1

2
3
4

5

76

 

By selecting any parameter with inserting the line use the right mouse button to open the popup menu for further commands: Select all, Deselect 
all, Select invert, Only select the parameters, Only select the info parameters, Edit parameters, Set to default value, Set to last value. 
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VMT (Further details are described in chapter 6.4) 

Echo map is a device specific (for non-contact principle) function.
 

By clicking the Get button the following echo data will be 
displayed: List number of the echoes, Distance, Amplitude in dB, 
Status. 
By clicking the Show Diagram button an Echo Map appears 
displaying the place of the received echo in the distant axis. The 
screen can be zoomed in and out and can be scrolled with the 
scrollbar tool at the bottom. 
Warning! Please note that the echo diagram does not show 
the real echo map, but only gives visual equivalent to the 
data in the echo table! 
 
When ticking the ‘Auto Refresh’ checkbox under the Get button 
and click the Get button a continuous cyclic Echo map querying 
will start with the selected cycle time. The cyclic querying can be 
stopped by clicking Cancel, or stops automatically if you leave the 
Echo Map window or close the Device Settings window between 
two cycles.  
 

With inserting the line of the received echo use the right mouse 
button to open the popup menu list with the following commands: 
Get, Auto refresh, Show Diagram, Save to file 
By clicking the Save to file.. button the Echo Map can be saved 
to an Echo Map file in ‘csv’ format. 
To leave the Advanced menu and go back to the Basic settings click the Basic button. 
To go back to the Device list simply close the window (Alt+F4). 
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5.7. REMOTE CALIBRATION 
The liquid analytical transmitters - using measurement electrodes - such as the AnaCONT LEP-100 series pH transmitters need to be recalibrated 
(its accuracy needs to be checked) between certain time intervals depending on the application utilizations in order to maintain the reliable 
measurement. The calibration intervals may vary from few days to several weeks. The measurement electrodes are aging during the usage of the 
instrument. When the life-time of the sensor is over the sensor should be replaced. In case of sensor replacement the sensor should be calibrated. 
This sensor calibration is aided with EView2 Calibration feature. 
 
The Calibration button is active only for the instruments which are able to perform remote calibration. 
By clicking the Calibration button or selecting the ’Device Calibration’ command in the right click 
popup menu the device-specific Sensor Calibration window appear: 

Along with opening the Sensor Calibration window the software automatically queries the calibration 
data and settings from the transmitter. By cancelling the parameter reading process you will exit from 
the Calibration window. After successfully reading the required data the device / sensor information is 
displayed. 

In the top line there is the calibration status. 
Below the Sensor Info part contains: Run time, Slope and Offset values for the ’After last Sensor Change’ and the ’After last Calibration’ time 
periods. 
The ’Temperature of the Sensor’ indicates the minimum, the current and the maximal temperature values of the sensor. By clicking the ’Refresh 
Sensor Info’ button the sensor data can be read out anytime. The ’Sensor Calibration Counter’ indicated the number of the calibrations performed 
with the given sensor. 

By clicking the ’Reset Timer’ button the sensor lifetime timer (run time after last calibration) can be 
reset after confirming the Warning window. 

 

By clicking the ’Show Calibration Data’ button the already queried calibration data is displayed in the 
‘Calibration Table’. 
 
By clicking the Refresh Calibration Table’ button in the Calibration Table window the calibration data 
can be queried again. By clicking the << Back button you can go back to the previous window, by 
clicking the Next >> button you can start the calibration procedure. 
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The appearing window displays a warning message that the user is about to change critical 
parameters of the measurement system. The ’No’ button results immediate exiting from the 
calibration procedure. By clicking the ’Yes’ button the software will entering the remote calibration 
mode of the device. After this step we can go on to the next window (Sensor Calibration - Step 1) 
by clicking the Next >> button. 

Upon that the calibration is an initial calibration or a periodic one, choose ’Yes’ or ’No’ to activate the 
Next >> button. To continue the calibration procedure click the Next >> button. 
By clicking the << Back button we can go back to the previous window. 
By clicking the Next >> button we can enter the Calibration Table (Sensor Calibration - Step 2): 

The Calibration Table window displays the pH values which are already calibrated. The calibration 
procedure is basically is done by editing the elements of this calibration table or adding new 
calibration points in accordance to the Sensor calibration chapter of the User’s and programming 
manual. 

In case of pH transmitter: 
By clicking the ‘Edit’ button the already existing calibration point can be modified, by clicking the 
‘Add New Item’ button new calibration points can be added a to the calibration table (up to 
maximum 8 elements).  
 
the ‘Edit’ and the ‘Add New Item’ button opens a new window where the desired calibration values can be modified or entered. 
 
By clicking the ‘Delete Item’ button an already existing selected calibration point can be cleared form the calibration table. 
By clicking the ‘Set Default’ button the factory default values can be restored. 
By clicking the ‘Refresh Calibration Table’ button the calibration data can be queried again. 
If the calibration values in the table are suitable for the measurement application and it is successfully saved to the instrument (it is indicated with 
the green tick before the list number) the calibration procedure can be finished with the ‘Close’ button. 
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By clicking the ’OK’ button on the ’Edit / Add New Calibration Item’ window the following window 
appears (Sensor Calibration - Step 3): 
 
Here the Sensor Value, the Buffer Value and the Sensor temperature is displayed. The measured 
(Sensor) value can be refreshed by clicking the ‘Refresh measure value’ button. If the ‘Auto cycle 
Refresh On’ checkbox is ticked under the button and then click the ‘Refresh measure value’ button 
the software will cyclically query the measurement value until the cyclic measurement data query is 
stopped by clicking again the ‘Refresh measure value’ button. 

To store the desired calibration point to the calibration table click the ’Store actual measure value’ 
button. If the Damping check On checkbox is ticked (the default state is ticked) prior to storing the 
calibration point a stabilizing progress starts. The trend bar indicates that the measurement value is 
stable enough for the storing. (If the tick is removed from Damping check On checkbox the software 
tries to store the actual calibration point, but ignores if the measured value is not stabilized.) 

During the stabilizing progress the software queries the measurement value repeatedly and when the measurement value is stabilized (in 
accordance to the entered buffer value) within the given time period the software send the calibration data to the transmitter. 
A Warning message appears if the measurement value is not stabilized between the given time 
period. This case the calibration point will not be saved. 

 

In case of successful sensor calibration a Confirm window appears informing about that the 
calibration point has been saved successfully: 

 

Along with the Confirmation about the successful saving of the calibration point there is a question to be answered whether there are more 
calibration points to be added to the calibration table or modifying any existing items. If the answer is ’Yes’ then the Sensor Calibration - Step 2 
window appears where the editing or the adding can be performed according to the previously described method. 
If the ’No’ option is chosen then a summary window appears containing the refreshed calibration 
table including the edited or newly added item. This window means that the calibration procedure 
was completed successfully. 
If any calibration item requires further modification click on the ’<<Back’ button to go back to the 
Sensor Calibration - Step 2 window. If everything is OK with the calibration table click on the ‘Close’ 
button to exit from the calibration mode. 
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6. THE POP UP MENU 
 

6.1. ELEMENTS OF THE POPUP MENU 

Many commands are available in the right mouse button popup menu, however some of them are only available after the successful device 
detection. The elements of the right mouse button popup menu are the following: 

 Detect 
 Stop detect 
 Polling on/off 
 Node settings 
 Device settings 
 Device calibration 
 All measuring window on 
 Close all measuring window 
 

 Select invert 
 Trend window on 
 Trend window close 
 All Trend window on 
 Close all Trend window 
 Show Device Status Window 
 Log window On/Off 

 
 

 
 
The commands of the popup menu such as Detect, Stop detect, Polling On/Off, and the Node settings has exactly the same function as the 
equivalent quick buttons in the menu bar. 
 
The All measuring window On command selects all detected devices in the device list by ticking the checkboxes. Then the Polling command (or 
button) will open all measuring windows and start the query of all measurement data. 
 
The multiple measurement windows can be closed by one click with the All measuring window close command. 
 



sas3030a0600h_02 ♦ 25/32 

 

6.2. TREND DIAGRAM 

When the Polling is running the Trend Diagram function becomes available to open: 

The selected 
measurement 
value is displayed, 
marked with the 
checkbox  

At the bottom section the measured value to be displayed can be selected: Primary Value, Current value, Lev, Lev%. Of course the displayable 
measurement values are in accordance to the selected instrument. Since the running Polling function is needed for the operation of the Trend 
Diagram, the maximal time interval is also 3 hours. 
 
The right mouse button popup menu provides further commands to use: Recording, Save Trend, Clear diagram, Zoom, Panels, Archive settings, 
Series, Diagram settings. The drop-down popup menu has many elements with multiple sub-menus. 
 
In the Recording drop-down menu Start and Stop commands can be selected. Both Start and Stop functions are available with F6 / F7 keyboard 
quick buttons. 
By clicking the Start button a new window appears with the file saving settings. 
 

File type

File path

Date and time format
- year, month, day
- hour, minute, second

The saved file can include 
the header datafields and 
the units of the values

The saved file can be joined 
to an existing file which can 
be browsed

The decimal separator 
can be selected

The default list item separator 
in a 'csv' file is ' ; ' semi-colon

The device specific data-field 
names can be modified 
by the user

 

In the Archive settings window the File type, Folder path, Date & Time format, Header options can be set. When clicking the Stop command the 
saving into file will be stopped. If we want to continue to saving, click again the Start command to continue the saving into the previously selected 
file. If we want to use a new file for saving use the right mouse button popup menu and select the Archive settings menu and then click the 
Settings command to open the above described Archive settings window. After filling the required settings click the OK button to start saving into 
the new file. 
If the Saving into file was running and then the saving has been stopped and after this the Saving settings (file destination) have been changed, 
this case when clicking the OK button only the file path is changed and for continue the saving into file process the Recording should be Started 
again. 
 
The Save Trend command (or button in the Right panel) opens the above described Archive settings window if the saving path was not set 
previously. The Save Trend command is counted from the first moment (when the Polling was started) and takes only until the moment of clicking 
the Save trend command or the OK button of the Archive settings window.  
 
Click the Clear diagram command to clear the previously made Trend diagram. This function has no effect on the saved trend diagram files. 
 
In the Zoom menu there are many possible options for customizing the diagram: Zoom+, Zoom-, Reset Zoom. 
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The Panel menu has multiple drop-down menus: Left Panel, Right Panel, Bottom panel, Buttons panel, All Panels On/Off. All menu points have 
other sub-menus allowing further setting possibilities. 

The Left Panel which is a toolbar panel on 
the left side includes the measurement 
values and the device info screen of the 
Polling window. The Left Panel can be 
customized by the right click popup menu 
with turning on or off the ‘Show Measured 
Value’ and the ’Show device info’ options. 

 

The Right Panel which is also a toolbar 
panel but on the right side including 
Archive Info, Archive settings and quick 
buttons related to the Recording menu. 
The Right Panel can be customized by the 
right click popup menu with turning on or 
off the ‘Show Archive Info’, and the Show 
Archive settings’ options. 

 
 
In the Archive settings the measured values can be selected which will be saved to file. Clicking the Start or the Save Trend will perform saving in 
accordance to the above described. The Settings button opens the Archive settings window. 
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In the Panels -> Bottom Panel menu 
there is a Show Bottoms Panel command 
activating a Browse toolbar under the 
diagram. 

 

 When the saving path has been already selected it is displayed here 

In the Panels -> Button Panel menu there 
is a Show Buttons Panel command 
activating quick buttons under the 
diagram: 

 

 The appeared quick buttons: 
Zoom+, Zoom-, Reset Zoom, Diagram settings 

The All Panels On/Off command is able 
to open or close all additional panels of the 
Trend Diagram with only one click. 
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6.3. STATUS 

By clicking the Show Device Status Window command in the right mouse button popup menu a Status and error information window appears. 
This information window is read-only and the actual status can be queried by clicking the Refresh button at the bottom. When any data transfer 
(read or write) is happening the status information is automatically get refreshed and the Refresh button became inactive. 

By clicking the Status 
or the Error line the two status 
windows can be collapsed

 

In the Status window there are device specific information displayed 
such as: Calculation mode, Relay operation, Factory settings, 
Simulation, etc.. 
Error indication is displayed in the Error window. 

 
 

6.4. LINEARIZATION (VMT – VOLUME MASS TABLE) 

In the Linearization curve menu point of the Device settings (see chapter 5.6.) the linearization can be turned ON or OFF. 

 

The required setting can be applied by Send button. 
 
The level, volume or flow values can be assigned to the measured values with the help of linearization. This can be advantageous in case of (level 
– level assignment for) different sound velocity (various gaseous media then the air) or lying cylindrical tank (level – volume assignment). 
 
The point pairs of the linearization table forms a max. 2x99 matrix displayed in 5 columns with separated columns for the dimensions for the source 
and the output values. The Source column contains the measurement values and the Output column contains the calibrated or calculated values. 
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The VMT table can be accessed in the Advanced menu: 

 

Click the Get button to read out the linearization table data from 
the device: 

 
 

The right mouse button popup menu provides the following options: 
 Edit item, 
 Add new item, 
 Insert new item, 
 Delete the contents, 
 Delete item, 
 Select all, 
 Deselect all, 
 Select invert, 
 Delete the contents of the all items, 

 Delete „Empty” items, 
 Renumbering, 
 Get VMT items from the device, 
 Send VMT items to the device, 
 Delete all VMT items from the device, 
 Load VMT list items from file, 
 Save VMT list items to file. 

 

The Edit item command opens a new window for editing a VMT value pair by entering the source and the output value. 

 
 
If the linearization table is not full and there is free space then the Add new item and Insert new item command is active in the right mouse button 
popup menu. 
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Click the Delete the contents of the selected items 
command to delete the content from more selected VMT 
items: 

Click the Get VMT items from the device. command to 
query the content of the linearization table: 

Click the Delete item(s) command to delete entirely the selected VMT item(s) 
 

Click the Delete „empty” items command to delete the VMT items not containing value pairs. 
 

Click the Renumbering command to refresh the list numbers of the VMT items. 

The Send VMT items to the device.. 
command uploads the linearization 
data to the device. 
If we have an existing VMT list file we 
can load it by clicking the Load VMT 
list items from file command. Then a 
new window appears where the file 
can be browsed: 

 
 

The VMT list can be saved to file by clicking the Save VMT list items to file command. Then the above described new window appears where the 
folder can be browsed where the file will be saved with the entered file name. 
We can choose from multiple file formats for the loading / saving, the VMT data can be saved in *.csv file format which can be read and write with 
Excel if the header format is standard. 
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7. TOOLS MENU 

In the Tools menu there are integrated, the configuration software related tools which perform handy features like the Parameter File Editor & 
Viewer and the Record File Viewer. 
 

7.1. PARAMETER FILE EDITOR & VIEWER 

The Parameter File Editor & Viewer is an additional tool which provides 
possibility to view, handle, even edit the operation parameters of any 
unconnected transmitter (in offline mode). 
 
Its usage is very simple, the operation of this tool is very similar to the 
Advanced mode / Parameters window. 
 
By clicking the Parameter File Editor & Viewer menu point in the Tools 
menu the following window appears: 
 
There are 3 buttons at the bottom part, ’Save to file...’, ’Load from file...’ and 
the ’Apply’ from which only the ’Load from file...’ is active by default. 

 

By clicking the ’Load from file...’ button a browsing window appears where a 
previously saved parameter list file can be browsed and opened by clicking 
the ‘Open’ button. 

The software automatically evaluates the parameter values during the loading and checks if the values are within the acceptable range and marks 
the elements which has wrong value. 
After the successful loading the parameters and the values are displayed in table form: 

In the upper side the ’Loaded Device Type’ indicates the device type which 
parameters are listed, and the rest of the window shows the parameters 
and the values. The first column of the table (P.No.) contain the number 
and the name of the parameter, the second contains the parameter values, 
the third contains the possible units. The selected parameter values can be 
edited by double-click or pressing the ‘Enter’ button, or by the right-click 
popup menu ‘Edit parameters’ command. If the selected parameter is 
allowed for user modification (or it is not a read-only parameter) then an 
Edit window appears. 

 

This window provides possibility to modify a parameter value in accordance 
to the User’s and programming manual of the given transmitter. Click the 
‘OK’ button to modify the value. When pressing the ‘ESC’ key or clicking the 
‘Cancel’ button the parameter value will not be modified. 
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The modified parameter values can be saved with overwriting the 
previously used parameter list file, or create a new one by clicking the 
‘Save to file..’ button. The parameters to be saved can be selected by 
ticking the checkbox. 
 
Note! Only the selected (by ticking the checkbox) parameters will be 
saved! 
 
By clicking the ‘Save to file..’ button a browsing window appears where 
the saving path should be selected and the file name should be entered. 

After entering the file name the clicking the ’Save’ button the selected parameters will be saved to file. By clicking the ’Cancel’ button or pressing 
the ’ESC’ key we can go back to the Parameter File Editor & Viewer window without saving the parameters to file. 

After the successful saving to file an Information window appear notifying that the 
parameters saved successfully done and indicating the number of the saved parameters. 
By clicking the ’Ok’ button will result to go back to the Parameter File Editor & Viewer 
window.  
 
To go exit from the Parameter File Editor & Viewer simply close the window (Alt+F4). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

sas3030a0600h_02.doc 

2014. February 

NIVELCO reserves the right to change technical data without notice! 


